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Windows 10 Support
BIOQUANT OSTEO now supports Windows 10 and Windows 7. 

We do not officially support Windows 8. BIOQUANT will probably work, but we haven’t tested under 
Windows 8, and we haven’t created a BIOQUANT profile for the interface, so it will look crowded.  We 
recommend you upgrade to Windows 10 if you are currently using Windows 8.

The installation program auto detects your version of Windows and installs the correct BIOQUANT 
profile for the operating system.

AFTER YOU INSTALL THIS VERSION: IF YOU UPGRADE WINDOWS 7 TO 10

• After you install this version, if you are a Windows 7 user and you click the Microsoft button 
to upgrade for free to Windows 10, contact us for directions on updating your BIOQUANT 
profile to Windows 10, as Windows does not let individual applications know this change has 
happened. 

If you don’t, it is not really a big deal. We just want to walk you through copying over a file that 
will make your BIOQUANT interface not so crowded.

If you are installing BIOQUANT on a PC that has Windows 10, and never had a previous version 
of Windows, you do not need to do this.

OSTEO: Protocol and Template Changes
The following changes have been made to the BIOQUANT  Templates, Sample Data Sets, and 
Protocols.

TOPIC CONTENTS

New: Sarcopenia Template, Protocol, and Sample Data Set

Updated: Osseointegration Template and Protocol

Updated: Stereology Template and Protocol

Updated: Human Templates

Updated: Bone Metastasis Template

NEW: SARCOPENIA TEMPLATE, PROTOCOL, AND SAMPLE DATA SET

OSTEO 2016 now has a standard template for the analysis of sarcopenia, the loss of muscle tissue 
associated with aging.

ABOUT THIS TEMPLATE

• This data set is designed for use with sections that have undergone some form of 
muscle specific staining. Analysis of muscle tissue by H&E staining can be exceptionally 
tedious. Common staining methods include myosin ATPase staining, dystrophin 
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immunohistochemistry, and dystrophin immunofluorescence. A nuclear counterstain can 
also be applied to identify “satellite cells” associated with the myocytes.

• New abbreviations have been added as needed to the BIOQUANT Terminology dictionary. 
The current terminology dictionary based, in part, on ASBMR nomenclature is located at 
http://osteo.bioquant.com/terminology.

ASSIGNED GUIDES AND LISTS

• Guide: Measure - Sarcopenia

• Selected List: Sarcopenia List

• Calculation List: Sarcopenia Calculation Set

TEMPLATE STRUCTURE

• A1 Whole Muscle Area

• A2 Satellite Cell Area

• P1 Satellite Cell X-Center

• P2 Satellite Cell Y-Center

• A3 (+) Myocyte Area

• P3 (+) Myocyte Diameter

• P4 (+) Myocyte X-Center

• P5 (+) Myocyte Y-Center

• D3 (+) Myocyte Optic Density

• A4 (-) Myocyte Area

• P6 (-) Myocyte Diameter

• P7 (-) Myocyte X-Center

• P8 (-) Myocyte Y-Center

• D4 (-) Myocyte Optic Density
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• D2 Calculations

• P9 Ms.Ar

• P10 (-) Mt.Ar

• P11 (+) Mt.Ar

• P12 Tt.(+) Mt.Ar

• P13 Tt.(-) Mt.Ar

• P14 Tt.Mt.Ar

• P15 Tt+Mt.Ar/Ms.Ar

• P16 Tt-Mt.Ar/Ms.Ar

• P17 TtMt/Ms.Ar

• P18 (+)Mt.Dm

• P19 Min(+)Mt.Dm

• P20 Max(+)Mt.Dm

• P21 Rng(+)Mt.Dm

• P22 (-)Mt.Dm

• P23 Min(-)Mt.Dm

• P24 Max(-)Mt.Dm

• P25 Rng(-)Mt.Dm

• P26 Mt.Dm

• P27 Ms.Dm

• P28 (+)Mt/MsDm

• P29 (-)Mt/Ms.Dm

• P30 Mt/Ms.Dm

• P31 (+)Mt.N

• P32 (-)Mt.N

• P33 Mt.N

• P34 Sat.Ce.N

• P35 Sat.Ce.N/Mt

• P36 (+)Mt.OD

• P37 (-)Mt.OD

PRIMARY DATA OVERVIEW

• A1 Whole Muscle Area is measured at low power using the Irregular ROI tool and 
General measurement type. This measurement sets the region of interest boundary for 
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counting myocytes and satellite cells. It is very similar to the “Tissue Volume” for skeletal 
phenotyping.

• A2 Satellite Cell Area and grouped arrays are measured at high power using the Measure 
Cells measurement type. By default, automatic thresholding is disabled and the cell 
threshold is drawn with the Draw tool. Auto ROI is active for this array so satellite cells 
cannot be measured outside the muscle area. The Measure Cells type prevents cells from 
being double counted in overlapping fields of view.

• A3 (+) Myocyte Area and grouped arrays is measured at high power using the Measure 
Cells measurement type. Automatic thresholding is used to identify cells based on stain 
color. Auto ROI is active for this array. The Measure Cells type prevents duplicate counts 
and accidentally counting half a cell at the edge of the field of view.

• A4 (-) Myocyte Area and grouped arrays is measured at high power using the Measure 
Cells measurement type. Automatic thresholding is used to identify cells based on stain 
color. Auto ROI is active for this array. The Measure Cells type prevents duplicate counts 
and accidentally counting half a cell at the edge of the field of view.

LEARN TO USE THE TEMPLATE

• Guide: (walks you through the protocol using a sample data set and sample image)

In the Guide region, from the Open button, choose “Measure - Sarcopenia” and follow the 
guide using a sample data set and sample images.

• Help / PDF Manual: (contains more details and pictures of what to do)

Click the ? Help button in the Measurement region to open the PDF Manual.  Under the 
“Bone Morphometry Protocols” header, click the link to “Bone Morphometry Protocols.” 
Then click the link to the Sarcopenia Protocol.

• eBook Manual: (same as the PDF Manual, but can run on your tablet)

In the BIOQUANT OSTEO 2016 eBook, from the Contents, choose “Sarcopenia Protocol.” 
It is listed under the “Bone Morphometry Protocols” header.

UPDATED: OSSEOINTEGRATION TEMPLATE AND PROTOCOL

The Osseointegration template, Osseointegration sample data set, and Osseointegration protocol 
have been changed so that the user identifies and measure Contact Surface at higher magnification 
using Auto Surface and Auto ROI.  The templates and protocol no longer support using Seg Assign on 
the low resolution image to identify Contact Surface.

CHANGES TO THE OSSEOINTEGRATION TEMPLATE

• The comment in the Calculation Array P3 Tt. Ar (mm2) has changed to: 
FIRST(D3)/1000000;mm2

This calculation uses the first value in D3 Total Area as the Total Area computation. 
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Previously, the calculation averaged the D3 Total Area values.

• The assigned Topo Arrays have changed.

The Osseointegration template now has two Topo arrays: D2 Topo Shrunk Image and D6 
Topo Zoomed Image. 

D2 Topo Shrunk Image is assigned to L1 Implant Perimeter and L2 Bone Perimeter and 
holds the implant, bone area, and total area topography.  

D6 Topo Zoomed Image is assigned to L3 Contact Perimeter and holds the contact surface 
topography. 

This reduces the redraw at high magnification, making it easier to see the bone to implant 
tissue surfaces and the Contract Surface redraw.

This change is seamless to the end user and does not change the protocol.

• L3 Contact Perimeter

The L3 Contact Perimeter array now uses Auto ROI and Auto Surface.

When using the Large Image Navigator at high magnification, on fields where the Total 
Area redraws, Auto ROI automatically create a region of interest from the Total Area 
redraw. This prevents measurement outside of the Total Area at high magnification.

Please note, Auto ROI is not supported on live images. Consider saving your tissue as a 
high resolution montage and loading it into the Large Image Navigator instead.

Auto Surface creates surface lines based on user defined tracings of the bone to implant 
contact surface. The surfaces redraw on subsequent overlapping fields to view to prevent 
duplicate measurement. 

CHANGES TO THE OSSEOINTEGRATION SAMPLE DATA SET

• OSTEO 2016 Sample Volume::Osseointegration sample data set has been updated.

The Osseointegration sample data set has been updated to measure Contact Surface 
at high magnification using Auto Surface and Auto ROI. It also has all the changes 
mentioned in the Osseointegration Template above.

This sample data set has a guide and sample image. It is a good place to start when 
learning osseointegration. In the Guide region, click the Open button, and then choose 
“Measure - Osseointegration” to open the guide. Then just follow the steps in the guide.

LEARN TO USE THE NEW TEMPLATE

• Guide: (walks you through the protocol using a sample data set and sample image)

In the Guide region, from the Open button, choose “Measure - Osseointegration” and 
follow the guide using a sample data set and sample images.

• Help / PDF Manual: (contains more details and pictures of what to do)

Click the ? Help button in the Measurement region to open the PDF Manual.  Under the 
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“Bone Morphometry Protocols” header, click the link to “Bone Morphometry Protocols.” 
Then click the link to the Osseointegration Protocol.

• eBook Manual: (same as the PDF Manual, but can run on your tablet)

In the BIOQUANT OSTEO 2016 eBook manual, from the Contents, choose 
“Osseointegration Protocol.” It is listed under the “Bone Morphometry Protocols” 
header.

UPDATED: STEREOLOGY TEMPLATE AND PROTOCOL

The Stereology templates support the Stereology Tools box, which is part of the optional BIOQUANT 
Imaging Extensions.  These templates have been updated to count Bone Hits and Bone Surface Hits 
on the Merz grid at high magnification instead of at the low magnification where the entire sample 
fits in the Image window.

CHANGES TO THE BONE STEREOLOGY REFERENT DATA TEMPLATE

• D6 Bone Volume Hits and D7 Bone Surface Hits now use Auto ROI. 

When using the Large Image Navigator at high magnification, on fields where the 
Tissue Volume redraws, Auto ROI automatically create a region of interest from the 
Tissue Volume redraw. This prevents measurement outside of the Tissue Volume at high 
magnification.

Please note, Auto ROI is not supported on live images. Consider saving your tissue as a 
high resolution montage and loading it into the Large Image Navigator instead.

• D6 Bone Volume Hits and D7 Bone Surface Hits now use the Manual Measurement Type

Previously, D6 and D7 used the General type. However, when measuring at high 
magnification within the Large Image Navigator, it is much faster to use the Manual 
Measurement Type because you can move around the section using the arrow keys and 
keep the measurement cursor in the Image window. 

• D1 Topo Tissue is now assigned to D6 Bone Volume Hits and D7 Bone Surface Hits

This allows all morphometry data to be stored in the same Topo array.

This change is seamless to the user and does not affect the protocol.

CHANGES TO THE BONE STEREOLOGY INITIAL TEMPLATE
The Bone Stereology Initial Template is a bare bones template with no Calculations and 
only two Measurement arrays: Tissue Volume and Object Count. This template is for the 
advanced user who want to design their own Stereology template by adding raw data arrays 
and calculation arrays and customizing the arrays to meet specific requirements. If you are 
getting started with bone stereology, we recommend you use the Bone Stereology Referent 
Data template first. If you have active technical services, you are welcome to contact us for help 
designing a custom template. 
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• D5 Object Count has been added to the template for counting hits on the grid at high 
magnification. It uses Auto ROI and the Manual Measurement Type.

This array can be renamed to match the kind of count you are tracking. As no calculations 
are attached to the D1 Compute Standard Indices array in the Bone Stereology Initial 
Template, you will need to add Calculation arrays.

When using the Large Image Navigator at high magnification, on fields where the 
Tissue Volume redraws, Auto ROI automatically create a region of interest from the 
Tissue Volume redraw. This prevents measurement outside of the Tissue Volume at high 
magnification.

Please note, Auto ROI is not supported on live images. Consider saving your tissue as a 
high resolution montage and loading it into the Large Image Navigator instead.

When measuring at high magnification within the Large Image Navigator, it is much 
faster to use the Manual Measurement Type because you can move around the section 
using the arrow keys and keep the measurement cursor in the Image window. 

CHANGES TO THE SAMPLE DATA SET

• OSTEO 2016 Sample Volume::Bone Stereology Referent Data has been updated.

The Bone Stereology Referent Data sample data set has been updated to count Bone 
Volume Hits and Bone Surface Hits at higher magnification using Auto ROI and the 
Manual Measurement Type.

This sample data set has a guide and sample image. It is a good place to start when 
learning bone stereology using the Merz grid. In the Guide region, click the Open button, 
and then choose “Imaging Extensions - Measure Bone Stereology Referent Data” to open 
the guide. Then just follow the steps in the guide.

LEARN TO USE THE NEW TEMPLATES

• Guide: (walks you through the protocol using a sample data set and sample image)

In the Guide region, from the Open button, chose “Imaging Extensions - Measure Bone 
Stereology Referent Data.”  This guides walks you through the new protocol.

• Help / PDF Manual: (contains more details and pictures of what to do)

In BIOQUANT OSTEO, from the Stereology menu, choose Stereology Tools. On the 
Stereology box, click the ? Help button to open the PDF Manual.  Under the “Stereology 
Referent Data Protocol” header, click the link to “Imaging Extensions: Stereology Referent 
Data ” to open the protocol.

• eBook Manual: (same as the PDF Manual, but can run on your tablet)

In the BIOQUANT OSTEO 2016 eBook manual, from the Contents, choose “Imaging 
Extensions: Stereology Referent Data” chapter. 
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UPDATED: HUMAN TEMPLATES

The Tb.Human -Tri TBlue Fl Template and Tb.Human - Single Slide Template no longer support 
segment assignment for measuring Single Labeled Surface. Single Labeled Surface is now measured 
using Auto Surface.

CHANGES TO THE TB.HUMAN -TRI TBLUE FL AND TB.HUMAN - SINGLE 
SLIDE TEMPLATES

• L10 (sLS) Single Labeled Surface now longer has the Segment Assign comment

In the past L10 (sLS) Single Labeled Surface was assigned to the General Measurement 
Type and had comments to use Segment Assignment to distribute the Single Labeled 
Surface based on the preview tracing.

In OSTEO 2015 we changed protocols and assigned L10 (sLS) Single Labeled Surface to 
the Auto Surface Measurement Type instead. Auto Surface proved to be faster and more 
straightforward.

In OSTEO 2016 we have removed the comments from L10 (sLS) Single Labeled Surface 
that allow Segment Assignment to happen.

This change is seamless to the end user and should not affect the protocol, unless you 
have still been using Segment Assign for single labeled surface data collection.

CHANGES TO THE SAMPLE DATA SET

• OSTEO 2016 Sample Volume::Human sample data set has been updated to match the 
Tb.Human - Tri TBlue Fl template

The Human sample data set has been updated to match the Tb.Human - Tri TBlue 
Fl template. The L10 (sLS) Single Labeled Surface array no longer has the Segment 
Assignment comment.

This sample data set has a guide and sample image. It is a good place to start when 
learning how to collect bone data on human trabecular samples. In the Guide region, click 
the Open button, and then choose “Measure - Tb. Human - Tri TBlue Fl - 1. Trichrome 
Data” to open the first guide in the three guide series. Then just follow the steps in the 
guide.

LEARN TO USE THE TEMPLATES
This change is seamless to the end user and should not affect the protocol, unless you have still 
been using Segment Assign for single labeled surface data collection. However, following are 
protocols that use the human trabecular templates.

• Guides: (walks you through the protocol using a sample data set and sample image)

In the Guide region, click the Open button, and then choose “Measure - Tb. Human - Tri 
TBlue Fl - 1. Trichrome Data” to open the first guide in the three guide series. Then just 
follow the steps in the guide.
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• Help / PDF Manual: (contains more details and pictures of what to do)

Click the ? Help button in the Measurement region to open the PDF Manual.  Under the 
“Bone Morphometry Protocols” header, click the link to “Bone Morphometry Protocols.” 
Then click the link to the Human Trabecular Bone Protocol.

• eBook Manual: (same as the PDF Manual, but can run on your tablet)

In the BIOQUANT OSTEO 2016 eBook manual, from the Contents, choose “Human 
Trabecular Bone Protocol.” It is listed under the “Bone Morphometry Protocols” header.

UPDATED: BONE METASTASIS TEMPLATE

The Bone Metastasis Template no longer supports segment assignment for measuring Osteoclast 
Surface. Osteoclast Surface is now measured with Auto Surface.

CHANGES TO THE BONE METASTASIS TEMPLATE

• L2 Osteoclast Surface now longer has the Segment Assign comment

In the past L2 Osteoclast Surface was assigned to the General Measurement Type and had 
comments to use Segment Assignment to distribute the Osteoclast Surface based on the 
preview tracing.

In OSTEO 2015 we changed protocols and assigned L2 Osteoclast Surface to the 
Auto Surface Measurement Type instead. Auto Surface proved to be faster and more 
straightforward.

In OSTEO 2016 we have removed the comments from L2 Osteoclast Surface that allow 
Segment Assignment to happen.

This change is seamless to the end user and should not affect the protocol, unless you 
have still been using Segment Assign for osteoclast data collection.

CHANGES TO THE SAMPLE DATA SET

• OSTEO 2016 Sample Volume::Bone Metastasis sample data set has been updated to match 
the Bone Metastasis template

The Bone Metastasis sample data set has been updated to match the Bone Metastasis 
template. The L2 Osteoclast Surface array no longer has the Segment Assignment 
comment.

This sample data set has a guide and sample image. It is a good place to start when 
learning how to collect bone data on human trabecular samples. In the Guide region, click 
the Open button, and then choose “Measure - Bone Metastasis” to open the guide. Then 
just follow the steps in the guide.

LEARN TO USE THE TEMPLATE
This change is seamless to the end user and should not affect the protocol, unless you have still 
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been using Segment Assign for osteoclast data collection. However, following are protocols that 
use the bone metastasis template.

• Guides: (walks you through the protocol using a sample data set and sample image)

In the Guide region, click the Open button, and then choose “Measure - Bone Metastasis” 
to open the guide. Then just follow the steps in the guide.

• Help / PDF Manual: (contains more details and pictures of what to do)

Click the ? Help button in the Measurement region to open the PDF Manual.  Under the 
“Bone Morphometry Protocols” header, click the link to “Bone Morphometry Protocols.” 
Then click the link to the Bone Metastasis Protocol.

• eBook Manual: (same as the PDF Manual, but can run on your tablet)

In the BIOQUANT OSTEO 2016 eBook manual, from the Contents, choose “Bone 
Metastasis Protocol.” It is listed under the “Bone Morphometry Protocols” header.

OSTEO: New Features and Enhancements
TOPIC CONTENTS

OSTEO: Multi-Band Threshold (Beta)

OSTEO: Threshold Region Redesign

OSTEO: Threshold by Scroll Wheel Improvements

OSTEO: Large Image Navigator Box Has More Step Sizes

OSTEO: Open Current Guide

OSTEO: Assign to Data Now Supports Measurement Filters

OSTEO: Undo Buttons Now On Measurement Region

OSTEO: dLS Measurement Type Enhancements

OSTEO: Batch Scripts Support Field Type

OSTEO: Minor Enhancements

OSTEO: MULTI-BAND THRESHOLD (BETA)

We are introducing a new Thresholding tool in OSTEO 2016. Our goal is to make is simpler and faster 
for the software to identify structures by stain color. We’re calling it Multi-band Threshold.

Thresholding marks the part of the image that is to be measured by a particular automatic 
measurement type. For example, before using the osteoid tool, the osteoid in the image must be 
thresholded. This can be done either automatically based on the color of the osteoid or manually by 
drawing with the Threshold Draw tool.
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Previously, a threshold was limited to a particular color and its lighter and darker shades. We noticed 
that when one stain transitions to another the mixed colors at the borders are difficult to threshold 
at the same time. Multi-band threshold means that it’s now possible to create one threshold from 
multiple colors and therefore more accurately detect objects to measure.

Multi-band Threshold is in the beta stage. This means is works well in our lab, but that it needs 
feedback from labs working with diverse samples in the real world. We look forward to and will 
be asking for your feedback. Currently Multi-Band Threshold works independently of traditional 
thresholding, however, the two methods will be integrated in future versions. 

MULTI-BAND THRESHOLD BOX

This is the new Multi-band Threshold box.

Quick Feature List:

• Multi-Band Threshold lets you create one threshold that combines different “bands” or color 
ranges within the image.

• To open Multi-Band Threshold box, click the Multi-Band button. 

This automatically checks the Multi-Band check box. The button and check box are currently 
linked. In future versions, after MB Thresholds can be assigned to arrays, this will no longer be 
the case.

• Multi-band Threshold can remember up to 10 different thresholds, created from up to 5 
different color ranges each.

• The MB Threshold drop list changes between the different thresholds. By default it start with 
number 1.  To switch between them, change the number in the MB Threshold drop list.

• Each MB Threshold number can contain up to 5 bands or color ranges. Each band has a Red (RH, 
RL), Green (GH, GL), and Blue (BH, BL) range. The “H” indicates the High limit on the range and 
the “L” indicates the Low limit of the range.

• Bands are set using the same thresholding process as before. In the Threshold region of the 
ribbon:
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• Use the Select button  to set the first threshold range. 

Make sure that the Red, Green, and Blue buttons are all ON (solid) in the Threshold 
region.

• Then, in the Multi-Band box, next to the band you would like to set, click the Record 
button. 

• Repeat for each band you want to assign.

• After you have set each band, you combine them into a single threshold by clicking the 
Refresh button in the Threshold region.

• To view an individual band, click the View button next to the band. 

After you click View, you can click Add in the Threshold region to add threshold to that 
particular band. Then click Record next to the band to update the band’s threshold ranges. 
Finally, click Refresh in the Threshold region to regenerate the multi-band threshold.

• To clear an individual band, click the Reset button next to the band.

• If Clean Bands is checked, when the Refresh button is clicked, BIOQUANT will apply the “Clean” 
command from the Editing region to each band before combining them into the final threshold. 
This helps remove “noise” from the threshold. For example, it can help eliminate non-specific 
staining in the marrow.

• If Show Bands is checked, BIOQUANT will keep the threshold on the screen when you are 
defining a new threshold range using Select and Add. 

• To display a threshold, use Refresh in the Threshold region to combine all threshold 
bands, or use View to display a single band. Then click Add or Select. The threshold will 
still be visible when the cursor enters the Image window.

• If Show Bands is not checked, the threshold will clear from the Image window as soon as  
Select or Add are clicked. 

• The New button will save all Multi-Band Thresholds to a new file on the hard drive. These files 
are stored in the “BQOSTEO2016\Multi-Band Threshold” folder.

• The Open button will let you open a Multi-Band Threshold file that has previously been saved 
to the Multi-Band Threshold folder.

• The Save button will save changes to the current Multi-Band Threshold file.

The software will save automatically if you use the MB Threshold drop list to define additional 
multi-band thresholds. If you’ve not yet saved the threshold, it will prompt you for a file name. 
Once the file name has been give, the software will continue to save automatically.

• In subsequent versions, you will be able to assign Multi-Band Threshold files to data sets and 
assign individual MB Threshold numbers to arrays.

• Currently, if you click on an array that has a threshold assignment, Multi-Band will turn OFF 
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automatically. If you plan to use Multi-Band Threshold in a data set, you should remove any 
traditional Threshold assignments from the arrays that will be used with Multi-Band Threshold.

• For a more comprehensive procedure, see the OSTEO PDF or eBook Manual. 

TO OPEN THE OSTEO PDF MANUAL TO THE CORRECT CHAPTER: 

• First make sure the OSTEO Manual is not already open. (If the manual is 
already open, when you click ? it will not open to the correct location.)

• Then, in the Threshold region, click the ? button to open the OSTEO PDF 
Manual to Threshold Region chapter. 

• In the Contents, click on Multi-Band Threshold. 

OSTEO: THRESHOLD REGION REDESIGN

The Threshold region has been redesigned to make room for Multi-Band Threshold. The features are 
still there, but they have been moved around. 

However, one small change is that you can no longer set the threshold range by clicking and dragging 
the color indicator. To set the threshold you now use either Select/Add or Multi-Band.

THE REDESIGNED THRESHOLD REGION

Multi-band Threshold has been added to the Threshold Region 

OSTEO: THRESHOLD BY SCROLL WHEEL IMPROVEMENTS

Since OSTEO 2015 the threshold could be adjusted by scrolling the mouse wheel up or down. 
Scrolling it up added similar colors and scrolling it down removed the least similar colors.

THE WAY THRESHOLD BY SCROLL WHEEL WORKS

• Click Select or Add and then click once on the structure that should be thresholded. 
This will give BIOQUANT the color of the stain that identifies the structure.

• Scroll up and BIOQUANT will expand the threshold automatically to include other 
similar colors.

• Scroll down and BIOQUANT will contract the threshold by removing the least 
similar colors.

We’ve improved Threshold by Scroll Wheel in the following ways: 
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• Automatically Choose the Starting Stain Color

When you click the Select button and scroll up, BIOQUANT will examine the image and choose 
the strongest stain color automatically and continue to expand the threshold to include similar 
colors.

This works best for tissues stained with a single stain such as TRAP staining or Calcein 
labeling.

• Add Specific Colors by Clicking

To add a specific color to the threshold, you can now just click on it. The threshold will be 
expanded to include that color. You can continue scrolling up and down to adjust the newly 
expanded threshold.

• Better Undo Support for Very Light and Dark Colors

Now when the threshold is very dark (near 0) or very light (near 255) the scroll up and scroll 
down behavior works symmetrically as expected. Previously, the 0 and 255 limits could skew the 
color ranges when trying scrolling down to remove less similar colors.

OSTEO: LARGE IMAGE NAVIGATOR BOX HAS MORE STEP SIZES

The Large Imaging Navigator has been enhanced with better navigation for very, very big images.

LARGE IMAGE NAVIGATOR

Pan Box Size Options: 1:2, 1:4, 1:8, 1:16, Shrink/Expand Image
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Two more Pan Box sizes have been added.

• Two New Pan Box Sizes: 1:8 and 1:16. 

For very high resolution images, in addition to Shrink image, you now can view the image with 
1:2, 1:4, 1:8, and 1:16 Pan Box sizes. 

• Only Supported Pan Box Sizes are Visible

If the images does not support a particular step size, its icon will not be on the Large Image 
Navigator.

OSTEO: OPEN CURRENT GUIDE

The Guide region has a new feature called Open Current Guide, which opens the current guide in the 
Guide Editor and highlights the current step. 

This really speeds up editing guides on the fly. If you haven’t created custom guides for your 
protocols, give it a try. They keep you trained and on task, especially when you haven’t done a 
protocol in awhile or when you are training the new recruit.

Here is a procedure:

1. In the Guide region, use the Next or Back arrows to navigate to:

• A step you want to edit

• A step you want to delete

• A step after which you want to add a new step

2. In the Guide region, from the Editor drop list, choose Open Current Guide.

The Guide Editor opens with the current guide open. The current guide step is highlighted.

GUIDE EDITOR - CURRENT STEP TAB

Edit the text.
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3. At this point you can edit the step, delete the step, or add new steps.

4. To see your changes, click the Save button and answer “Yes” to the confirmation message.

In the Guide region, the current guide updates to match the changes. You should be on the 
same guide step that you were on when you executed Open Current Guide, unless you deleted it, 
then you will be on the next guide step.

OSTEO: ASSIGN TO DATA NOW SUPPORTS MEASUREMENT FILTERS

Once objects are thresholded, Measurement Filters allow the software to select objects based on their 
shape, specifically cross-sectional area, circumference, and roundness. 

For example, Measurement Filters can help the software accurately identify adipocytes even though 
they are often the same white color as tears or gaps in the marrow. Adipocytes are often round 
whereas tears are often irregular. Similarly, it’s possible to use size to differentiate between multi-
nucleated TRAP positive osteoclasts and TRAP positive monocytes. Finally, it is helpful to know that 
Measurement Filters use calibrated units so they work across magnifications without adjustment.

Measurement Filter files can now be assigned to data sets using Assign to Data Set. Individual filters 
are also assigned to specific arrays.

This saves time as you no longer have to load the Measurement Filter file when you come into 
BIOQUANT OSTEO. Also, if you use the data set as a template for another data set, you won’t have to 
load the Measurement Filter file with the new data set. 

In fact, if you haven’t checked out assigning Selected Lists, Guides, Calculation Lists, and 
Measurement Filters to the data set, you really should. They save time and keep you organized!

ASSIGN TO DATA SET

Assign to Data Set now supports Measurement Filters.

Here is an outline of the procedure:

1. Use Measurement Filters to create several filters and assign the different filters numbers to 
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different arrays.

Measurement Filters can filter based on Area, Perimeter, Height, Width, Shape, X position, and 
Y position.

Use “Set Filter by Sampling” if you want the system to generate the filter for you.

See the OSTEO Manual “Measurement Region: Tools List” chapter for more directions.

MEASUREMENT FILTERS BOX

The Current Filter Number can be assigned to the current Selected Array.

2. From the File menu on Measurement Filters, use Save As to save a file in the BQOSTEO\
Measurement Filters folder. 

It is helpful to name the file the same as the data set so it is easy to find.

3. From the File menu, choose Assign to Data Set.

4. On the Assign to Data Set box, select the Measurement Filter file you saved in the Measurement 
Filter drop list.

Measurement Filter files located in the BQOSTEO\Measurement Filters folder are automatically 
listed in the Measurement Filter drop list.

At this point, if you have created a Guide, Selected List, or Calculation List for this data set you 
can select them in their corresponding drop lists as well.

5. On the Assign to Data Set box, click the OK button.

Now, if you exit BIOQUANT, when you come back in the Measurement Filter file (plus the Guide, 
Selected List, and Calculation List, if assigned) will automatically be loaded. 

If you have assigned the Measurement Filter to the first array in the Selected list, the 
Filter Number assigned shows up as active (not gray) in the parenthesis next to the word 
Measurement in the Tools list.

COMPREHENSIVE PROCEDURE

For a more comprehensive procedure, see the “Measurement Regions: Tools” chapter 
in the OSTEO Manual.
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OSTEO: UNDO BUTTONS NOW ON MEASUREMENT REGION

Now instead of going to the Edit menu to Undo a measurement, you can simply click the Undo button 
in the Measurement region.

Undo works with all Measurement Types.  Undo reverts the system to its state before the “Measure” 
button was clicked. Undo reverts both the morphometric and topographic data.

Here is a procedure:

1. Make a mistake using any of the Measurement Types.

2. Click the Undo button.

ADDITIVE / SUBTRACTIVE MODE NOTE

Undo does not work with Additive or Subtractive Mode ON. 

Additive and Subtractive mode are legacy features we had before we implemented the 
Calculations box. 

If you are still using Additive or Subtractive mode, contact us and we will help redesign 
your templates so you don’t have to.

If you don’t know what Additive or Subtractive mode is, ignore this comment and don’t 
start using them...they will be disappearing in future versions.

OSTEO: DLS MEASUREMENT TYPE ENHANCEMENTS

The following enhancements have been made to the dLS Measurement Type.

1. dLS Measurement Type: Max Width Length parameter

To avoid issues with C and S shapes, a new dLS Setting has been added called “Max Width 
Length.” The default is 50. If the width lines on C and S shapes are darting to the wrong surface, 
lengths above this value will be excluded. They will be marked with a square, but no line will 
extend from the square and no data value will be recorded.

To set the Max Width Length, in the Measurement region (dLS Type), click the Settings button. 
Then on the Settings box, change the Max Width Length and click OK.

SETTINGS

Settings should only be changed at the beginning of a study.
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2. dLS Measurement Type: Spacebar to End checkbox status

On the dLS Type, the Space to End box is now defaulted to always ON.

OSTEO: BATCH SCRIPTS SUPPORT FIELD TYPE

The Batch Script Editor now supports the Measure button in the Field Measurement Type.

To add the Measure Field command to a batch script:

1. In the Batch Script Editor, click the Add Steps button. 

2. Then, in the Add Steps box, scroll to the Measure Field command. 

3. Double click to add it to your Batch Script.

OSTEO: MINOR ENHANCEMENTS

The following minor enhancements have been added to BIOQUANT OSTEO:

1. Open Data Set: Data Volumes box now displays path 

In the Data Volumes box, next to the Data Volume name, the path to the Data folder is now 
shown.

FILE PATHS NOW APPEAR ON OPEN DATA SET

The paths appear to the right of the data set name. 

2. Measure Cells: Measurement Filter Number Display

In the Tools list, the Measurement Filter number next to “Measurement” now updates when you 
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click on an array with a Measurement Filter assignment.

3. Open Single Image/Open Image Sequence:  

a. Opens .tiff Extension

The BQ Open Image and BQ Open Sequence boxes now list “.tiff” as well as “.tif” files.

b. Compressed TIF Error Message

BIOQUANT now gives an error message if you try to load a compressed TIF image.

4. ROI Region: The Spacebar to End checkbox has been removed

The Spacebar to End checkbox has been removed. When defining ROIs using the iROI Cursor 
or Irregular ROI Types, the Spacebar to End functionality is always ON now. You can tap the 
keyboard spacebar to end the ROI tracing definition, or simply click the right mouse button to 
exit the Image window and end the ROI tracing definition.

5. The following boxes have been renamed:

a. Calculations box: Rename

The Calculations box has been renamed Calculate to fit within Windows 10 title bars.

b. Strut box: Rename

The Strut Analysis box has been renamed Strut to fit within Windows 10 title bars.

c. Batch Script Editor: Rename

The name of the “Batch Measurement Editor” box has been changed to “Batch Script 
Editor.”

6. Osteoid Measurement Type: Auto Fill Threshold & Opacity

On the Osteoid Measurement Type, when you click Measure, the system auto fills holes in the 
threshold. In the previous versions, the auto filled threshold had an opacity of 100%, even if the 
Opacity was set to another value. Now, the opacity of the auto filled holes matches the opacity 
set by the Opacity drop list in the Threshold region. 

7. Osteoid Measurement Type: Manual Set Ends State Remembered

On the Osteoid Measurement Type, in the Settings box, the “Manual Set Ends” state is now 
remembered across BIOQUANT sessions. This allows users with large cortical bone to keep 
Manual Set End ON since BIOQUANT’s auto detect osteoid ends algorithm was designed for 
small osteoid seams.

8. Large Image Navigator: View Whole Image Removed

The View Whole Image has been removed. It was a legacy feature that no longer supports very 
large digital images.

9. Core OSTEO software: Pseudocolor and Histogram no longer supported

Pseudocolor and Histograms have been moved to the Imaging Extensions add-on. This allows 
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us in future versions to add continued support for DICOM images, density output tables, and 
monochrome cameras.

10. Returning from Data Manager: Calculation box remembers previously open Calculation List

The Calculation List that was open when you executed Data Manager from OSTEO is now open 
when you return to OSTEO from Data Manager.

Imaging Extensions: Enhancements
The following enhancements have been made to the BIOQUANT Imaging Extensions add-on.

IMAGING TOOLKIT: MONTAGE UP TO 4 GB

The Imaging Toolkit has the following enhancement:

• Montage up to 4 GB

The Imaging Toolkit can now create a montage up to 4 GB, as long as the system has enough 
resources.

STEREOLOGY TOOLS: IMPROVED LOAD STEREOLOGY DEFAULTS

The Stereology box has the following enhancement:

• Improved Load Stereology Defaults: The Stereology Defaults button now does the following:

Items that are different than in the previous version are preceded by the word “CHANGE.” 
These changes improve the Stereology Merz grid protocol. See the Stereology Referent Data 
protocol in the OSTEO Manual.

• The first Topo array in the data set will be set as the Topo Array in the Parameters region.

• The second Topo array in the data set will be set as the grid array.

• The third Topo array in the data set will be set as the point array.

• On the Overview Window, Redraw All Mode is checked.

• On the Overview Window, Draw Point Mark is checked.

• On the Overview Window, Black Background is checked.

• On the Overview Window, Auto Size/Position Reset is checked.

• CHANGE - On the Overview Window, You Are Here box is checked.

• CHANGE - On the Topo menu, Assign System Redraw>Clear All + Redraw is checked..

• CHANGE - On the Topo menu, Assign System Redraw>Topo + Grid + Points is checked.

• CHANGE - On the Options menu, Extent to Live is no longer checked. (State remains the 
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same as prior to clicking Load Stereology Defaults.)

• CHANGE - On the Options menu, Live Manual Measure is no longer checked. (State 
remains the same as prior to clicking Load Stereology Defaults.)

• CHANGE - On the Options menu, Live Redraw All is no longer checked. (State remains the 
same as prior to clicking Load Stereology Defaults.)

SCAN: Enhancements
The following enhancements have been made to the BIOQUANT SCAN add-on.

OSTEOIMAGER: MOVE MENU ITEMS UPDATE PARAMETERS

The OSTEOIMAGER has the following software enhancement:

• On the Scan menu, the Move to Next Objective and Move to Previous Objective menu items now 
change the Parameters Mag entry, as well as change objectives on the microscope. 

IMPORTANT CALIBRATION CHANGE

In order for the Move to Next Objective and Move to Previous Objective to work, you 
need a magnification label for all objective slots, whether or not there is an objective in 
the slot. 

If you have empty, unused objective slots, you will need to add a Magnification Label 
for the empty slot named “Empty.” When BIOQUANT sees the word “Empty”, it will 
skip over that objective and move to the next non-empty slot.

With the OSTEO 2016 installation, an OSTEOIMAGER.CAL file has been added to the 
BQOSTEO\Calibration Backup folder for you to use as a guide.  If you load this file, you 
will see that it has the following Magnification Labels: X4, X10, X20, X40,  Empty (5), 
Empty (6)

Calibrate for the objectives that are on the OSTEOIMAGER. If you are not using some 
of the objectives that are labeled, change the name to include the word “Empty.” Just 
make sure that there is a Magnification Label for all objective slots.

AUTO SEQUENTIAL IMAGING: AUTO FOCUS WORKS

Auto Sequential Imaging has the following enhancement:

• Auto Focus now works with Auto Sequential Imaging. Previously Auto Focus was not used 
with Image Capture. For directions on how to use Auto Focus, see the Auto Sequential Imaging 
procedure in the Manual.
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